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Formulas 

What is a formula? 

Formulas allow you to perform and construct mathematical calculations and equations. 

 

Arithmetic 

Operators 

Meaning Example 

+ Addition 2+2 

- Subtraction 2–1 

* Multiplication 2*2 

/ Division 2/2 

% Percent 10% 

   

 

 

Formula construction basics 

• Start in the cell you want your answer to appear in 

• Type in an equals sign =  to tell Excel you want to construct a formula 

• Use the cell address B2, B3, B4 etc not the actual number in the cell (the number might 

change!) 

• Click on the cell with your mouse, to include it in the formula, rather than typing in the cell 

address, separate each cell address with an operator i.e. + 

• Your formula will appear in the cell and in the formula bar 

• Push Enter to finish the formula after selecting the last cell  

Cancel  Confirm   Formula Bar 

Answer 
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Creating a Formula 

1. Click in the cell that you require the result, press = on the keyboard 

2. Click in the first cell i.e. A1 

3. Press the operator required i.e. + 

4. Click in the second cell i.e. A2, continue steps 2 and 3 

5. Click on the last cell to include in the formula (do not select an operator again) 

6. Finish by clicking the Confirm tick or pushing Enter on your keyboard 

 

 

Tip:  Press = to begin your formula 

 

 

Tip:  Build formulas using the mouse or cursor key rather than typing cell references 

Editing a Formula 

7. Select the cell containing the formula 

8. Double click on the cell to edit or select the cell and press F2 

9. Edit your formula in the cell or in the Formula Bar 

10. Press ENTER or TAB to confirm or click the Confirm tick 

 

 

Tip:  To view all formulas on your sheet press CTRL ~. 

Copying Formulas 

Use the AutoFill handle to copy formulas from one cell to another.  

11. Select the cell containing the formula 

12. Hover your mouse over the small black square in the bottom right corner of the active cell.  

 (your mouse should change to a thin black cross)  

13. Drag the small black square across or down as required 

The formula will be copied down, and will change based on the row that you are in.  If the original 

formula was =D2*E2, by row 4 the formula will have changed to = D4*E4 and by row 10 it will have 

changed to =D10*E10.  This is called relative referencing, i.e. the formula changes relative to the row 

that you are in.  

 

Tip:  Double click the AutoFill handle to copy the formula down to the first blank row in a 
column. 
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Order of Operation 

The order in which Excel formula are calculated uses the BEDMAS convention.  This means that 

calculations within Brackets are first, followed by Exponents, followed by Division and Multiplication, 

and finally Addition and Subtraction.   

Order of Operator Precedence 

Brackets 

Exponents 

Division 

Multiplication 

Addition 

Subtraction 

 

 

Where there is only multiplication and division in the formula, they hold the same rank, so are 

calculated left to right, in the absence of brackets. 

Where there is only addition and subtraction in the same formula, they hold the same rank, so are 

calculated left to right in the absence of brackets. 
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Functions 

What is a function? 

Functions are predefined formulas and are already available in Excel. All Excel functions have the 

same structure.  

Function Syntax Symbol Meaning 

Equals sign = Tells Excel to do a calculation 

Function Name SUM Word that tells Excel what to do, ie SUM tells 

Excel to add 

Open bracket ( Starting point for providing the data, used to 

separate the word from the data 

Cell or range of cells E2:E26 Start cell and end cell. A colon : is used to say 

“from”, ie everything from E2 to cell E26 

Comma , Separate each part of the function or each range 

of cells 

Close bracket ) Completes the function and tells Excel your 

finished 

Example =SUM(E2:E26,G2:G26) Add up all the numbers in cells E2 to E26 and 

G2 to G26 

Commonly Used Functions 

The most commonly used functions are: 

Function Use For Adjacent Cells Non Adjacent Cells 

SUM Totals a range of 

cells 

=SUM(1st cell : last cell) =SUM(1st cell, 2nd cell, 3rd cell) 

AVERAGE Totals and divides by 

the number of cells 

=AVERAGE(1st cell : last 

cell) 

=AVERAGE(1st cell, 2nd cell, 3rd 

cell) 

MINIMUM Returns the lowest 

value in a range 

=MIN(1st cell : last cell) =MIN(1st cell, 2nd cell, 3rd cell) 

MAXIMUM Returns the highest 

value in a range 

=MAX(1ST cell : last cell) =MAX(1st cell, 2nd cell, 3rd cell) 

COUNT Counts the number 

of numbers in a 

range 

=COUNT(1st cell : last cell) =COUNT(1st cell, 2nd cell, 3rd cell) 

Creating a Function 

14. Click in the cell where you require the result 

15. Type =SUM( 

16. Drag the range of cells i.e. A1:D1 (for a continuous range) 

or 
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17. Click the first cell, hold CTRL and click the second and subsequent cells i.e. A1, D1, E1 (for 

cells that are not next to each other) 

18. Close the bracket ) 

19. Finish with Enter or   i.e. = SUM(A1:D1) 

Editing a Function 

20. Double click the cell with the function  

21. Amend as required 

22. Finish with Enter or  

 

Tip:  Note that all these functions have the same syntax.  Ie =, followed by a word that tells 
Excel what to do, followed by an open bracket, a range of cells, and finally a closed bracket. 

Formula Autocomplete 

Formula Autocomplete allows you to start typing the function name and then select the correct 

function from a short list. 

 

23. Select the cell where you want your answer to appear. type the = (equal sign) and 

beginning letters of your function to trigger Formula AutoComplete 

24. As you type, a scrollable list of valid items is displayed with the closest match highlighted 

25. Detailed ScreenTips help you make the best choice 

26. Double click on the function required, the function name will complete and the bracket will 

be opened ready for you to select your data 

 

27. Complete the function, close the bracket and push Enter 
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Function Wizard 

You can use Insert Function to help you insert the correct function and arguments for your needs. 

Search for a function 

 

28. On the Formula bar click Insert Function fx 

29. Either select the function from the most commonly used list, or select a category to narrow 

down your search 

 

30. Click once on the function to select it, choose OK 

 

Your function will require at least one cell or range of cells to complete the calculation. Required 

arguments will show in bold, optional arguments are not bold.  So, for the MAX function, at least one 
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cell or range of cells is required, but you could provide more than one set of cells (maybe you want to 

the find the maximum across two ranges of data) 

31. Use the collapse/expand dialog button to collapse up the wizard if it is covering your data, 

otherwise simply select the range of cells you want to include in your function.  Click the 

collapse/expand button again to see your wizard. 

32. Provide data for all bold arguments 

33. Choose OK to finish the function. 

 

Help on this function 

 

You can click the hyperlink Help on this function if you would like to open the online help topic for the 
specific function you’re working on. 

Using AutoSum 

34. Click the cell where you’d like your answer 

35. Click AutoSum from the far right on the Home tab 

36. AutoSum will write the sum function for you and take a guess at the cells you want to add.  

Check the range of cells is correct, modify if necessary 

37. Click AutoSum again to confirm or press Enter  

 

 

Tip:  Use drop down arrow next to AutoSum to access other functions 
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When would you use a formula vs a function? 

Functions are designed to save time when you are dealing with larger lists. 

Simple addition, subtraction, division or multiplication is best dealt with using a formula. 

 

Adding a column of numbers with 5, 10, or 200 values would be best managed with a function 

 

As your formula and function experience grows you will end up combining formula within functions. 

The following IF function contains a simple multiplication formula B5*J8 

=IF(B5>J4,B5*J8,0) 
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Absolute vs Relative Referencing 

A reference is the address of the cell containing the data or values needed in constructing a formula.   

You have already seen relative referencing in action, when filling a formula down Excel uses relative 

referencing to change the formula based on the row number.  When filling a formula across, Excel 

changes the formula based on the column letter. 

Sometimes you don’t want the reference to change as you copy the formula. If this is the case, you 

need to use absolute cell referencing.  You may be including a constant in your formula, i.e. GST, a 

value for mark up, margin etc.  Best practice would be to put each of these values in a cell and 

reference that cell in your formula.  By marking the constant as an absolute reference, the cell 

reference won’t change when you fill the formula.  If the value of your constant changes (GST rate, 

margin), you can change the value of your one cell and all formula referencing that cell will update. 

You can combine relative and absolute referencing within a formula. 

Relative Reference Absolute Reference 

  

When the formula in cell C1 is copied to cells C2 

and C3, cell references in the copied formula 

are adjusted to reflect the relative position of the 

formula in C2 and C3 

When the formula in C1 is copied to C2 and C3, 

cell B1 remains the same since this is an 

Absolute Reference. 

To make a cell an Absolute Reference in a 

formula, type a dollar sign ($) before the parts 

of the reference that do not change 

Switching between Absolute and Relative References 

38. Click on the cell with the formula 

39. Position the cursor next to the cell reference to change in the formula bar 

 

40. Press F4 (function key) 
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Variations of References 

The F4 function key rotates through four settings 

$A$1 Both column and row references are fixed 

A$1 Row reference only is fixed 

$A1 Column reference only is fixed 

A1 Neither column or row references are fixed, they are relative 

 

 

Tip:  Marking a cell reference within a formula as absolute prevents the cell reference in the 
formula from incrementing when it is copied. 
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Useful Functions 

The following functions are some of the most commonly used within a workbook containing large 

amounts of data.   

COUNT Function 

The COUNT function is used to count the number of cells in a range that contain numbers.  The 

syntax is made up as follows: 

 

Example 

In the following example, the function has been used to calculate the total number of order amounts: 

 

 

 

Tip:  Use CRTL + SHIFT + down arrow, to select a range of cells when constructing a 
formula. Use CTRL + Backspace to return to your formula. 
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COUNTA Function 

The COUNTA function is used to count the number of cells in a range that are not empty.  The syntax 

is made up as follows: 

 

Example 

In the following example, the function has been used to calculate the total number of non-blank cells 

within the Department column:  
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COUNTIF 

The COUNTIF function is useful when you want to count a number of cells within a range based on a 

specific criteria, i.e., the total number of sales for a particular region. The function syntax is made up 

as follows: 

 

In the following example the COUNTIF function will look down the region column (range) and count 
how many times Auckland appears (criteria). 
 
COUNTIF requires a constant value as its second argument.  This could be a reference a cell that 
contains the criteria or you could include it within the function.  If included in the function this argument 
must be put within a pair of double quotes.  E.g. =COUNTIF(Region, “Auckland”) 

Example 

In the following example COUNTIF is used to calculate the total number of orders for each region: 

 

Select the cell where you want to create the formula 

41. Enter  =COUNTIF( 

 

42. Select the range of data you want to include, i.e., the column containing the criteria (except 

for the headings) followed by a comma.  Before adding a coma, consider making the range 

absolute if you want to fill the formula down 
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43. Create the criteria, i.e., in this example if you want to extract data for Auckland enter the 

cell reference for the cell containing the text Auckland. This is better practice than typing in 

“Auckland” as you would need to edit each function for Christchurch, Wellington… whereas 

by using the cell reference you will be able to fill the formula down 

 

44. Close the bracket and press Enter – the result will be displayed 

 

 

Tip:  When creating complex formulas, you may find that the formula runs over cells 
that you want to select as part of the formula.  To avoid this, click into the cell you want 
the result in, then click in the Formula Bar and type = to start the formula. 

 

More criteria options 

Your criteria in the COUNTIF may be to count all items greater than, less than or not equal to a value.  

If this is the case the following is useful to consider. 

When you want to use a relational operator other than = (e.g., <>,>, etc.), you need to have the double 
quotes around the operator and the value, for example =COUNTIF(range,">4"). 
 
If you want to use a value stored in a cell as part of your criteria, then you need to use the & character, 
for example =COUNTIF(range,">"&B1).   The & in =COUNTIF(range,">"&B1) is evaluated first, that is, 
the value in B1 is fetched and concatenated with ">". The result is that the formula now contains a 
constant together with a relational operator in double quotes and this is what gets evaluated. 
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SUMIF 

The SUMIF function is useful when you want to add data within a range based on a specific criteria, 

i.e., the total amount of sales for a particular region.  The syntax is made up as follows: 

 

 
Like the COUNTIF function if you want to use a value stored in a cell as part of your criteria, then you 
need to use the & character, for example =SUMIF(A1:A2,">"&A3). 

Example 

In the following example SUMIF is used to calculate the total value of sales for the Auckland region. 

Firstly you will need to define the region and then the city within the region and finally, where the data 

is to sum. 

 

Select the cell where you want to create the formula 

45. Enter  =SUMIF( 
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46. Select the range of data that includes your criteria, i.e., the column containing the cities 

(except for the headings) followed by a comma.  Remember to consider an absolute cell 

reference if you wish to fill the formula. 

 

47. Create the criteria, i.e., in this example if you want to extract data for Auckland enter the 

cell reference for the cell containing the text Auckland, followed by a comma 

 

48. Select the range of data that you wish to sum, i.e., the column that contains the $ amounts 

that you want to add up.  Consider whether this range should be made absolute. 

 

49. Close the bracket and press Enter – the result will be displayed 
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TEXT 

You can use the TEXT function to convert a numeric value to text, for example you want to determine 

which day of the week a specific date may fall on, so you can ascertain busy periods. 

 

Example 

In the following example TEXT is used to calculate the day of the week and the month in which orders 

have been placed 

 

Select the cell where you want to create the formula 

50. Enter  =TEXT( 

 

 

51. Enter the cell reference containing the information you are looking up, followed by a comma 
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52. Enter the text format you want to display (the following table suggests format options) 

Format Result 

“d” or “dd” Returns the numeric value of 

the date, i.e., 1 or 01 

“ddd” Returns an abbreviated text 

format, i.e., Fri 

“dddd” Returns the full text format, i.e., 

“Friday” 

 

53. Close the bracket, press Enter and your result will be displayed 

 

Day, month and year formats 

Format Result 

“d” 1 

“dd” 01 

“ddd” Sat 

“dddd” Saturday 

“m” 7 

“mm” 07 

“mmm” Sept 

“mmmm” September 

“yy” 18 

“yyyy” 2018 

dd/mm/yy 01/07/18 
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Logical Functions 

The following functions are the most commonly used when results are required based on the outcome 

of a test on the data. 

IF 

The IF function returns one value if the condition you specify is TRUE, and another value if the 

condition that you specify is FALSE.  For example, if a salesperson reaches over and above a specific 

target, they will receive a bonus, otherwise they won’t.  The syntax is made up as follows: 

 

The test element of the IF statement must be able to return a true or false answer, so is constructed 

using the following: 

Operation Symbol Example 

Greater than or  

greater than or equal to 

> 

>= 

B5>H4 

B5>=H4 

Less than or  

less than or equal to 

< 

<= 

B5<H4 

B5<=H4 

Equal to = B5=H4 

Not equal to  <> B5<>H4 

Example 

In the following example, IF is used to determine whether a salesperson receives a bonus based on 

their achieving a target of $15,000.  The resulting true or false, could return the answer in the form of 

text or a formula, or even a blank. I.e.”Yes” they got their bonus or “No” they don’t, or it could return 

the value of the bonus payment. 
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Select the cell where you want to create the formula 

54. Enter  =IF( 

 

 

55. Enter the cell reference on which you want to base the logical test (in this instance you are 

referencing to a cell rather than entering the actual sales target figure in the formula) 

followed by a comma 

 

 

56. Enter the value you want to appear if the logical test is true – enter this information within 

quotation marks – followed by a comma 

 

 

57. Enter the value you want to appear if the logical test is false – enter this information within 

quotation marks 

 

58. Close the bracket and press Enter – the result will be displayed 
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Lookup Functions 

Lookup functions allow you to search for some data and then return relevant information about the 

item you’ve looked up. For example, you might look up a product code and return its name, price, or 

description.   

VLOOKUP 

The V in VLOOKUP stands for “Vertical”. This means the function will look down through a list/table to 

find an item.  There are a few things to know about VLOOKUP. 

• The item you are looking up must be in the left most column of the table you are looking up. 

(This doesn’t necessarily mean column A – but does mean that the first column you define as 

your table must be the column you’ll find the lookup value in) 

• You can ask the function to look for an exact match or an approximate match. If looking for an 

approximate match the data in the left most column that you’re looking up MUST be sorted in 

ascending order. (A-Z or smallest to highest) 

• The VLOOKUP function will return a corresponding value, from the same row, from a specified 

column in the table.  You specify a column number by counting the number of columns to the 

right of the first column you defined, i.e. column 2, 3, 4 etc. 

Note:  The values in the first column of the table must be unique. 

 

 

Example 

In the following example, VLOOKUP is used to find out the bonus percentage paid to Sales Staff. 

 

Select the cell where you want to create the formula 

59. Enter  =VLOOKUP( 
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60. Enter the cell reference containing the information you are looking up, followed by a comma 

 

 

 

61. Select all of the data in the table (except for headings), this will insert the Named Range if 

you applied one to the lookup table, followed by a comma 

 

 

62. Enter the column index number where the information is located (in this instance the Bonus 

% is located in the second column).  

 

 

 

Tip:  When creating LOOKUP functions, it is good practice to make your table array 
absolute or to create a Named Range for the table.  This ensures that if you copy the 
formula elsewhere, you are always using the correct data.  To make the table absolute 
press F4 when you have selected your table array. 
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63. You can also add a TRUE or FALSE argument to the formula depending on whether you 

want an exact match or an approximate match.  You would add FALSE when the values in 

the first column of your lookup table are not sorted.  Use TRUE if you want to find the 

closest match and the data in your first column has been sorted in an ascending order.  The 

default value is TRUE. 

64. Close the bracket, press Enter and your result will be displayed 
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Create and Use Range Names 

Naming cells or ranges of cells can be very useful when constructing formulas and functions.  It can 

make your formulas easier to read and makes life much easier if you are needing to reference cells in 

other sheets.  For example =SUM(unit_cost) might be easier to read than =SUM('INDEX & 

MATCH'!F2:F101), where ‘Index & Match!’ is the sheet name and F2:F101 is the range of cells. 

Named ranges can be driven by you or you can have Excel create ranges for you by using the Format 

as Table feature.   

• Use named cells/ ranges, where you want to give a cell or selection of cells within your 

current worksheet or other worksheet a name to make formula easier to follow 

• Use Format as Table if your data is large lists with column headings that you will want to 

manipulate via sorting and filtering, add columns with calculations within the table, create 

PivotTables or regularly need to add data to. 

Create a Named Range 

65. Select the cell(s) that you want to name 

66. Click the Name box at the left end of the formula bar  

 

67. Type the name that you want to use to refer to your selection. Names can be up to 255 

characters in length, but cannot contain spaces, use an underscore if necessary ie 

unit_cost 

68. Press Enter 

Define a name by using a selection of cells in the worksheet 

You can convert existing row and column labels to names 

69. Select the range that you want to name, including the row or column label(s) 

70. On the Formulas tab, in the Defined Names group, click Create from Selection 

 

71. In the Create Names from Selection dialog box, designate the location that contains the 

labels by selecting the Top row, Left column, Bottom row, or Right column check box 

Define a name by using the New Name dialog box 

72. On the Formulas tab, in the Defined Names group, click Define Name 

 

73. In the New Name dialog box, in the Name box, type the name that you want to use for your 

reference.  Names can be up to 255 characters in length 

74. To specify the scope of the name, in the Scope drop-down list box, select Workbook or 

the name of a worksheet in the workbook 
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75. Optionally, in the Comment box, enter a descriptive comment up to 255 characters 

76. In the Refers to box, do one of the following:  

 To enter a cell reference, type the cell reference. The current selection is entered by 

default. To enter other cell references as an argument, click Collapse Dialog  

(which temporarily shrinks the dialog box), select the cells on the worksheet, and then 

click Expand Dialog  

 To enter a constant, type = (equal sign) and then type the constant value. 

 To enter a formula, type = and then type the formula 

77. To finish and return to the worksheet, click OK 

Manage names by using the Name Manager dialog box 

Use the Name Manager dialog box to work with all of the defined names and table names in the 

workbook.  

To open the Name Manager dialog box, on the Formulas tab, in the Defined Names group, click 

Name Manager. 

 

Change a name 

If you change a defined name or table name, all uses of that name in the workbook are also changed. 

78. On the Formulas tab, in the Defined Names group, click Name Manager 

79. In the Name Manager dialog box, click the name that you want to change, and then click 

Edit 

80. In the Edit Name dialog box, in the Name box, type the new name for the reference 

81. In the Refers to box, change the reference, and then click OK 

82. In the Name Manager dialog box, in the Refers to box, change the cell, formula, or 

constant represented by the name 

 To cancel unwanted or accidental changes, click Cancel , or press ESC 

 To save changes, click Commit , or press ENTER 

Delete one or more names 

83. On the Formulas tab, in the Defined Names group, click Name Manager 

84. In the Name Manager dialog box, click the name that you want to change 

85. Select one or more names by doing one of the following:  

 To select a name, click it 

 To select more than one name in a contiguous group, click and drag the names, or 

press SHIFT and click the mouse button for each name in the group 

 To select more than one name in a non-contiguous group, press CTRL and click the 

mouse button for each name in the group 

86. Click Delete. You can also press DELETE 

87. Click OK to confirm the deletion 
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Tip:  By definition named ranges are absolute so are great for using in formula 
construction where you are referencing a specific table or range of cells and need to fill 
the formula. 

  



Microsoft Excel - Data Presentation Quick Analysis 

 Page 34 

Quick Analysis 

Quick Analysis allows to you to quickly apply a function to your selected data, including the Sum, 

Average, and Count functions. 

88. Select your data 

 

89. Click once on the Quick Analysis button that appears at the bottom right of the selected 

data  
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90. Click on the word Totals and hover over each of the options Sum, Average, Count etc.  

The solution will show in live preview.  Click the option you want 

 

The first five options apply a function to your columns (blue), the next set of functions apply to your 

rows (yellow). Use the arrow to see more row options. 

If you wanted to show both column and row totals, and you’ve already applied column totals, select 

your data again, use Quick Analysis, navigate to the row options and select the option you want to 

apply. 
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Format as Table  

If you have data that you need to sort or filter, then Format as Table is a very useful tool.  Not only will 

it apply the auto filtering options, apply a colour scheme to make it easier to read, it will also set your 

data up so you can append more data later and the table will expand to accommodate your data.  In 

additional the table becomes a named range which can help with function construction and it sets the 

data up for creating PivotTables.  

 

Tip:  Data sets should not contain blank rows or columns.  If your data does contact blank 
rows or columns it is a good idea to tidy the data up first. 

 

1. Click anywhere within your data, or select your data and then choose Home, Format as 

Table  

2. Click on an appropriate colour scheme to select it   

  

3. From the dialog box, check that all the data is selected and the check box for My table has 

headers is checked if appropriate. 

4. Select OK 

5. Returning to the Format As Table option will now allow you to apply a different colour 

scheme if you wish 

Format As Table automatically turns on auto filter for your data. 

You will also have a contextual command tab called Table Tools 

 

From within Table Tools you can 

• Rename your table 

• Create a PivotTable,  

• Tidy your data up by removing duplicates if necessary,  

• Change the colour of your table and which rows are banded. 
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Working with column and table names 

By using Format as Table the table and columns have been named.  When creating formula the 

names of table and columns will be used rather than the cell references, this is called a structured 

reference.  

You can add additional columns or rows and your table will expand automatically. As you construct 

formula the cell reference is replaced with the “structured reference” which refers to the column 

heading e.g. [@[Order_Amount]].  The structured reference makes it easier to read the formula. Once 

the formula is complete it will fill to the bottom of the table without the need to use the fill handle. 

[@Order_Amount]  refers to the current row 

[@[Order_Amount]] is a relative reference in the Order_Amount column 
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Filtering and Sorting Data 

You can turn Sort and Filter on without using Format As Table. 

6. Click anywhere in a cell containing numeric data 

7. On the Home tab, in the Editing group, click Sort & Filter, and then click Filter  

 

The filter dropdown boxes should now show in the header row of your data. 

The following section will apply whether you have used Sort & Filter or Format as Table. 

Sort or Filter a numeric column 

Filtering data is a quick and easy way to find and work with a subset of data in a range of cells or 

table.  Once you have filtered data in a range of cells, you can either reapply a filter to get up-to-date 

results, or clear a filter to redisplay all of the data. 

1. Click the arrow  in the column header 

2. Do one of the following:  

2.1 Sort your data from smallest to largest or largest to smallest.  You can even sort by 

colour of cells if you have applied conditional formatting or your own formatting.  See 

section on Conditional Formatting. 

2.2 You can filter your data either by the colour of cells (conditional formatting) or by 

using one of the Number Filters 

2.3 Filter your numbers based on entering a number in the Search box 

2.4 Filter your numbers by turning off Select All and then ticking the values you which to 

filter for 

   

3. Choose OK to apply your filter 

A filtered column will show with this symbol  

Sort your data into 
numeric order or 
sort by colour of 
cell (conditional 
formatting) 

Search for a 
specific number in 
the Search box or 
uncheck Select 
All and then 
check the values 
you want to filter 
for 

Filter by cell 
colour or using 
one of the 
number filters 
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A sorted column will show with this symbol with the arrow showing the direction of the sort, in this 

case smallest at the top and largest at the bottom. 

To remove a filter 

1. Click on the filter symbol you wish to clear.  

2. Either choose, Clear Filter from column name or choose to turn on the tick box for Select 

All 

 

Working with Number Filters 

1. Point to Number Filters and then click one of the comparison commands or click Custom 

Filter 

 

2. Ensure the comparison operator is showing the correct option ie is greater than vs is 

greater than or equal to 

3. In the Custom AutoFilter dialog box, in the box on the right, enter numbers or select 

numbers from the drop down list, choose OK 
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Create a multi condition numeric filter 

1. Point to Number Filters and then click Between or Custom Filter 

 

2. Use the And condition to filter for values that are between two numbers 

3. Use the Or condition to select say top and bottom values, ie is less than 100 or over 200 

4. Choose OK to apply the filter 

Sort or Filter Text  

1. Click the arrow  in the column header 

2. Do one of the following:  

2.1 Sort your data from A-Z or Z to A.  You can even sort by colour of cells if you have 

applied conditional formatting or your own formatting.  See section on Conditional 

Formatting. 

2.2 You can filter your data either by the colour of cells (conditional formatting) or by 

using one of the Text Filters 

2.3 Filter by typing text in the Search box 

2.4 Filter by turning off Select All and then ticking the items you which to filter for 
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Conditional Formatting 

Use conditional Formatting to highlight cells that meet your desired criteria.  Using conditional 

formatting can make it easier to identify key data. 

Conditional Formatting 

A conditional format changes the appearance of a cell range based on a condition (or criteria).  If the 

condition is true, the cell range is formatted based on that condition.  If the condition is false, the cell 

range is not formatted based on that condition.  

Options are available by selecting a group of data and clicking on Conditional Formatting from the 

Styles groups on the Home tab: 

 

Built-in Rules 

Excel has provided you with built-in rules.  By selecting the option Highlight Cells Rules from the 

drop-down list available under Conditional Formatting, a number of built-in rules are already 

available for use: 

1. Select the cells you would like to apply the conditional formatting to first 

2. Select Home, Conditional Formatting and then built in rule group you’d like and finally the 

specific rule  

Use these options to clear 
existing rules, or edit a rule. 
Use New Rule to create 
your own rule. 

The Built-In Rules provide 
you with a quick and easy 
way to apply conditional 
formatting across selected 
data 



Microsoft Excel – Data Presentation Conditional Formatting 

 Page 42 of 52 

 

3. From the rule box, you can then adjust to criteria (number) and then also select the colour 

scheme you’d like applied 

 

4. Choose OK 

Removing a Rule 

1. On the Home tab, in the Styles group, click the arrow next to Conditional Formatting, and 

then hover over Clear Rules and select one of the options available 

 

Manage Rules 

The built in rules can be changed by using the Manage Rules option. 

1. On the Home tab, in the Styles group, click the arrow next to Conditional Formatting, and 

then click Manage Rules 
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2. Any rules that are currently applied to the spreadsheet will show in the Conditional 

Formatting Rules Manager window 

3. You can do the following: 

3.1 Create a New Rule 

3.2 Edit an existing rule.  If multiple rules, click on the rule first and the choose Edit Rule 

3.3 Delete the rule, remember to select it first 

3.4 Change the range of cells that the rule Applies to 

 

4. Select the rule and then click on Edit Rule 

 

5. Make the required changes, such as how many values will show, or choosing a different 

colour scheme under Format 

6. Click OK, Apply and OK  
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Creating a New Rule 

Sometimes the built-in rules don’t give you the formatting you need so you will want to create your 

own rule.  A good example below would be you want to highlight all the cells where the actual cost is 

higher than the budgeted cost, when you have two columns of data 

1. Select the column of data you wish to apply the rule to 

2. From the Home tab, select Conditional Formatting then select New Rule  

3. Choose the rule type: in this case Use a formula to determine which cells to format 

 

4. In the Format values where this formula is true field you will want to create the formula 

for one row ie =$C$3<$D$3. This formula is testing if Budgeted Cost is less than Actual 

Cost 

5. You then need to remove the $ from the row context so the formula can fill down the 

column and look at each row and test.  So the resulting formula will look like =$C3<$D3 

 

6. Next choose Format and choose a font colour or background fill colour to apply if the 

formula is true, choose Ok 

7. Click OK 
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If you forgot to select the column that the formatting should apply to before creating your conditional 

rule or you need to alter it in the future, then you can choose Edit Rule and change the range the rule 

Applies to 

 



Microsoft Excel – Data Presentation Create a Pivot Table 

 Page 46 of 52 

Create a Pivot Table 

A PivotTable is an interactive table that combines and compares large amounts of data.  It is possible 

to rotate (or pivot) the rows and columns to see different summaries of the source data, and display 

details according to your areas of interest. 

Main Elements 

To understand the components of a PivotTable it is necessary to understand PivotTable terminology. 

Term Description 

Axis A dimension in a PivotTable such as a row, column or page 

Data Source The list or table containing the data used to create the PivotTable 

Field A category of information.  A field is similar to a column in a list. PivotTables 

can be manipulated by selecting specific fields, i.e., Salesperson, Region, etc. 

Item A member of a field, i.e., Salesperson’s name 

Summary 

Function 

The function used to calculate the values displayed in the main part of the 

table (SUM is the default for numerical data and COUNT for text) 

Refresh Recalculating the PivotTable to reflect any changes in the data source 

PivotTable Ribbon 

PivotTable Tools, Analyze  

 

PivotTable Tools, Design 

 

Generating a PivotTable 

It is always a good idea to format your data as a table before creating your PivotTable especially if you 

will be adding more data to the table later, as the Format as Table feature will expand the table to 

include new data appended.  See section on Format as Table earlier in this manual. 

1. Click anywhere in the data to be summarised in a PivotTable 

2. On the Insert tab in the Tables group, click the PivotTable icon  

 

3. Ensure the correct data range is selected and click whether you want the PivotTable to be 

put into the existing worksheet or a new worksheet and click OK.   If your data is formatted 

as a table, the table name will show in the Table/Range field. 
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4. An empty PivotTable will be created 

 

 

5. Tick which fields are to be added to the report.  By default, nonnumeric fields are added to 

the Rows area, numeric fields are added to the Values area, and OLAP (Online Analytical 

Processing) date and time hierarchies are added to the Columns area 
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6. You can drag the fields between different areas if required 

 

 

Tip:  If the range is in another worksheet in the same workbook or another workbook, click 

 and select the data source.  This will insert the workbook and worksheet name at the 
start of the range using the following syntax: [workbook name]sheetname!range) 

 

Use Recommended PivotTables 

The Recommended PivotTables feature will show a subset of PivotTable types that are appropriate to 

the data you’ve selected. To use the tool: 

1. Click anywhere in the data you want to summarise 

2. On the Insert tab in the Tables group, select Recommended PivotTables 

 

A dialog appears with a range of PivotTables to choose from: 
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1. Click each PivotTables in turn to see how your data will look in that format 

2. Select the desired option and click OK.  The PivotTable will be created automatically 
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Excel Keyboard Shortcuts 

General Shortcuts 

Shortcut Key Description 

ARROW KEYS Move one cell up, down, left, or right 

TAB Move one cell to the right. 

SHIFT TAB Move one cell to the left. 

CTRL, ARROW KEY Move to the last column in the worksheet  

HOME Move to the beginning of the row. 

CTRL HOME Move to first cell in worksheet. 

CTRL END Move to the last cell on the worksheet. 

PAGE DOWN Move down one screen. 

PAGE UP Move up one screen. 

ALT PAGE DOWN Move one screen to the right. 

ALT PAGE UP Move one screen to the left. 

CTRL SPACEBAR Select the entire column. 

SHIFT SPACEBAR Select the entire row. 

CTRL A Select entire worksheet. If it contains data, CTRL A selects the 

current region. Pressing it a second time selects entire worksheet. 

ALT ENTER Start a new line in the same cell 

CTRL ENTER Fill the selected cell range with the current entry. 

ESC Cancel a cell entry. 

F4 or CTRL Y Repeat the last action. 

CTRL Z Undo the last action. 

CTRL X Cut 

CTRL C Copy 

CTRL V Paste 

F2  Edit cell contents 
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PivotTables 

Keyboard Description 

F11 Generates a PivotChart based on the selected PivotTable 

CTRL SHIFT * Select the entire PivotTable 

ALT SHIFT RIGHT 

ARROW 

Group selected items  

ALT SHIFT LEFT 

ARROW 

Ungroup grouped items 

CTRL PAGE 

UP/DOWN 

Move to previous/next sheet in workbook 

 


